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ASMITA_lite Manual Version 1.0
Summary
This manual provides details of how to use the ASMITA software, guidance on setting-up models and
a series of Appendices that detail the theoretical background and some of the current limitations. It is
accompanied by some sample models and a number of spreadsheets:
Southampton Water.mat
Southampton water 2shore.mat
ASMITA_lite program structure.xls
Blank model parameters.xls
SW4e model parameters.xls
SW4e_change.xls

four element model of Southampton Water
mix of 2-sided and single bank representation of estuary
reaches
details subroutines that make up the model
spreadsheet to help define model parameters
worked example for one of the sample models
sample spreadsheet detailing changes used in Southampton
Water model.
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1
INTRODUCTION
Definition: Aggregated Scale Morphological Interaction between a Tidal inlet and the Adjacent coast
(ASMITA).
This manual has been written as a guide to using the Matlab ASMITA model and illustrates the
concepts and methodology used in long-term morphological modelling.
Figure 1

Schematisation of an estuary or inlet into a number of elements as used
in ASMITA
Outside world

Delta

Barrier
Channel

Barrier

Storage

Tidal flat

Saltmarsh

The idea behind ASMITA is that a tidal basin, or estuary can be sub-dividing into a number of
elements (Figure 1). Each element has an equilibrium condition when unperturbed and following
some form of perturbation (eg. sea level rise, addition or removal of volume or area) the model seeks
a new equilibrium. For example, if under initial conditions the accommodation space is zero (no net
change in the transport of sediment), with increased mean sea level the accommodation space
becomes positive and sediment may be imported, the opposite is true when sea level falls. The key
concepts of the ASMITA model are:
•
•
•
•
•
•

The estuary is schematized into a number of geomorphologic elements;
The state of each element is described by its volume and plan area (water or sediment);
Integrated parameters of hydrodynamics (tidal prism, or tidal range) are used;
Empirical relationships define the morphological equilibrium for each element;
Deviation from the morphological equilibrium causes sediment demand; and
A gradient in sediment demand drives sediment transport, and thereby morphological change.

Appendix A describes the theory and concepts used within the ASMITA model.
Note to Users:
This manual seeks to explain how to use the ASMITA software. It also provides some guidance on
how to set-up a model and how certain aspects of the model work. However, if when using the model
you come across issues that are not explained in the manual please either draft a suitable addition to
the manual, or send a short note describing the issue to one of the developers (see Acknowledgments).
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2

GETTING STARTED
2.1

About ASMITA Software

The ASMITA software has been written using the software language Matlab, version R2007a (Figure
2). The software utilises only the functions present within Matlab and does not require additional
toolboxes. Distributed alongside this manual is a document that details the relationships between the
various routines that makeup the ASMITA program.
Figure 2.

2.2

The ASMITA program has been developed using the software Matlab
R2007a from Mathworks

Opening ASMITA

Within Matlab navigate to the folder containing the Matlab ASMITA scripts. From the command line,
type asmuilite; (Figure 3) this command will invoke the installation and setup of the ASMITA
graphical user interface (GUI).
Figure 3.

To load and run ASMITA type ‘asmuilite;’ within the command widow

asmuilite;
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Figure 4.

The Matlab environment after calling the ASMITA program

Global variables, these
contain the information used
for running ASMITA

The information entered into the ASMITA model (type, properties, flow, diffusion rates and so on)
are contained within global variables stored within the Matlab environment. This information is used
throughout the various routines and stored in memory throughout the lifetime of the application. The
user can view this information either through the graphical plotting interface provided in the software
(Section 7), or from the excel spreadsheet that is generated to record all of the input data and the
model results on a series of worksheets. From within Matlab the user can also interrogate both global
and local variables from the workspace window (Figure 4).
Note:

Within Matlab, information is stored as numbers, cell arrays and structured arrays.

On entering ‘asmuilite’ the following splash screen appears (Figure 5) for a few seconds before being
replaced by the ASMITA interface (Figure 6).
Figure 5.

Splash screen acknowledging the project partners who have
contributed to the ASMITA program
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Figure 6.

The ASMITA interface

Version and Menu
Options.

Project name and scenario are
displayed here. This information is
entered by the user when creating a
new project.

Project date, this is automatically
added after creating a new project

The user is able to control all aspects of the ASMITA model through the ASMITA interface (Figure
6), there is no requirement for the user to access data or commands through the Matlab command
window.
Note:

Users have full access to the code that will enable them to make fine adjustments to the controlling
algorithms. For example, additional driving forces may be needed that are not described in the current
setup. Having full access to the software code allows the user to add additional functionality.
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3

FILE MENU

From within the ASMITA interface (Figure 6) there are a number of menu options. The menu item
FILE allows the user to perform a number of file operations such as open or create a new instance of
ASMITA, exit the program or save the current model setup. The following section explains the
options available to the user for each of these items under the FILE menu.
3.1

New (Create a New Model Setup)

After selecting New from the File menu option a series of popup windows will appear. The user is
asked a number of questions regarding the project name and scenario (Figure 7). This information will
be displayed in the ASMITA interface (Figure 6).
Figure 7

3.2

A series of dialog windows appear after selecting the New menu item

Open (Open an Existing Model)

Information regarding existing ASMITA models can be stored within a Matlab work file (*.mat). The
*.mat file contains the information regarding the complete model setup including element and system
defined properties.
Select an existing ASMITA model setup file from the common dialog box. By default the *.mat file
extension is visible (Figure 8). An example *.mat project is provided along with the model scripts.
3.3

Save and Save As

The user can save the current setup of the ASMITA model by selecting Save or Save As from the File
menu item. If the user selects Save without first specifying a name then the program will, by default,
request a name from the user.
3.4

Exit

The user can exit the ASMITA program at any point by going to the Exit menu item in the File drop
down list.
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Figure 8.

Shows the dialog window that appears after selecting the Open menu
item. Only *.mat files should be selected
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4

TOOLS MENU

Within the ASMITA model software there are a number of tools, designed to assist in the building
and visualisation of the model elements. Also included are a number of tools that allow the user to
clear unwanted figures or clear the whole ASMITA model setup.
4.1

Load Image

In order to have some context or point of reference of the system being modelled, an image can be
loaded as a background map. This can help the user visualise the schematised approach. On selecting
Tools → Load Image a dialogue box appears allowing an image file to be selected which is then
loaded as a background to the user interface as illustrated in Figure 9.
Figure 9.

Load Image option from the Tools file menu

The user is able to select from the following image types:
ID Num
1
2
3
4
5
6
7

4.2

File Type
JPEG File Interchange Format (*.jpg, *.jpeg)
Tag Image File Format (*.tif)
Windows Bitmap (*.bmp)
Portable Network Graphics (*.png)
Hierarchical Data Format (*.hdf)
PC Paintbrush (*.pcx)
X Window Dump (*.xwd)

Model Image

To save an image of the model setup containing both any background map or image and the element
boxes select Tools → Model Image. A Save As dialogue box opens prompting the user to define the
folder and file name that the image is to be saved to. The default is to save the image as a JPG file at
600 dpi.
Note: this can be modified by editing the ‘print’ definition in file cb_fil5.m.
4.3

Refresh

The Refresh function updates the screen image, if an image appears incorrectly then use the Refresh
function to redraw the screen image.
4.4

Clear Model/Figures

The Tools → Clear → Clear Model function resets all parameters in ASMITA, allowing the user to
start the process of setting up an ASMITA model without the need to close the whole application.
Tools → Clear → Clear Figures function will delete any open plot windows (Under the Plot menu,
Section 7) the user can plot selected information in numerous windows). To simply close all figure
windows click the Clear Figures function from the drop down menu list.
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5

SETUP MENU

The setup menu comprises forms to define the system properties, the individual element properties
and the time step parameters to be used.
5.1 System
System properties are not element dependent, that is to say the information defined within the system
properties represents the whole environment. The System menu includes a number of menu options
for general properties, water level information, a definition of user defined changes to the system (ie
perturbations over the duration of the model run), saltmarsh properties and the option to update older
versions of model files to version 1.5.
5.1.1
System - Properties
The user can access the system properties by selecting Setup → System → Properties from the
menu drop down list. Tool tips for the System properties provide a brief definition, or advice on
default values, and are displayed when the user hovers over a specific entry field.
Figure 10

System Properties data entry

This is the sediment concentration that is
the global value of the “external”,
usually marine, environment.
Sediment and water densities with
default values shown.
Index of the most seaward ‘channel’
element .
The width e-folding length is used if
tidal pumping is included
Wind speed, sediment median grain size,
critical bed shear stress, and water
viscosity are used calculation of erosion
of marsh edge and some equilibrium
methods. In the current version these
properties are specified for the system as
a whole rather than on an individual
element basis.
Project and scenario titles and set-up data
are entered when creating a new project
(Figure 7) and can be edited here.
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5.1.2
System - Water Level Properties
Additional system properties related to water levels are accessed by selecting Setup → System →
Water levels. Tool tips for the Water Level properties provide a brief definition, or advice on default
values, and are displayed when the user hovers over a specific entry field.
Figure 11

Water Level Properties data entry

The tidal range at the mouth and if
element specific values are not defined
(see Element Properties) then this value
is used for all elements.
M4 constituents and the S2/M2 ratios
are used in the tidal pumping
calculation and to define the duration of
submergence over a spring-neap cycle.
Rate of sea level rise (see note below)
Any number of long-term cycles can be
specified and these are used to vary the
tidal range over time. The GUI checks
that the number of values entered for
phase, amplitude and period agree with
the number of cycles specified. The
values shown here are for a nodal cycle
and long-term cycle.
The LW/HW factor adjusts the
proportion of change in tidal range
apportioned to high and low water.
Option included because of observed
bias (eg on Humber nodal tidal cycle
has an amplitude of 0.23m with a high
water amplitude of ~0.14 and low water
amplitude of ~0.08 ie factor = 0.08/0.23
= 0.35). The default value is 0.5.
Note: There is an option to include a non-linear rate of sea level rise. This has the format:
dslr = -yr0.slr0, where yr0 is the start year for the start of an exponential rate of slr and slr0 is the
rate at yr0. The rate of exponential increase is hard coded as 0.011. For yr0=1900, slr0=1mm/yr,
and ert=0.011 slr is 1mm/yr in 1900, 3mm/yr in 2000 and 5mm/yr in 2050 and 9mm/yr in 2100.
5.1.3

System – Change

Changes can be defined as one or more adjustments to the volume and/or surface area of individual
elements to represent alterations to the system. The user can specify specific periods where a known
change in an element may have occurred, for example a capital dredge or some engineering works, or
a repeating cycle such as may be needed to represent maintenance dredging.
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To specify a change in the element the user should select Setup → System → Change. The user is
provided with 3 options New, Edit and Load. Each menu item refers to an excel sheet that can be
generated from within the ASMITA interface by selecting New and then subsequently edited using
Edit. The Load option uploads the linked excel sheet into the model.
Note: Creating and Editing a file saves the path and file name of the excel worksheet in the model but
not the data. This must be loaded using the Load option.
After selecting New, an excel sheet will be generated. The default is to crate the file in the current
working directory with the file name ‘Change.xls’. If the defaults is selected (Figure 12) all previous
information stored in the ‘Change.xls’ file will be lost. A separate sheet will be generated for each
element that has been defined by the user. Each worksheet (numbered 1 to n) will have the header
information shown in Figure 13.
Figure 12

Messages and prompts when creating a New Change excel spreadsheet

Figure 13

Excel Spreadsheet created to hold Change data

Element Name
Year of change and
associated change in
volume (m3) and
surface area (m2).

Element Number
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The user then enters years (within the specified simulation period and using decimal values for parts
of a year) and the change in area and volume associated with that year. Years of change must be
entered in ascending order, ie. 2000, 2004, 2005 and so on. The user can specify the change to either
all elements, or to just selected elements.
Note: The change specified is specific to the number of elements and period of the model. The
generation of the Change file may take several minutes, depending on the number of elements.
Once a change file has been generated, the user can edit this at any time using the Setup → System
→ Change → Edit option. This opens the previously created change file, or gives the option to
select a different change file (Figure 14). The path and file name is stored in the model, replacing any
previous file. Once the edits have been made and saved the excel worksheet should be closed before
attempting to load the data into the model.
The user can load or edit an existing ‘Change.xls’ file by selecting /Load. After selecting either Edit
or Load the ‘Change.xls’ file will open and the user will be able to amend this. The user must then
close Excel before moving on to other operations within the ASMITA program. Matlab will
determine when the ‘Change.xls’ file has been closed and prompt the user to update the global
variables. Selecting yes will update the system change variables within the global defined variables.
Figure 14

Messages and prompts when editing a Change excel spreadsheet

To load new change data or alter the change data that may have already been loaded use the Setup →
System → Change → Load option. This reads the file that has previously been linked to the model
using the New or Edit options and loads the data into the model (Figure 15).
Figure 15

Messages and prompts when loading data from a Change excel
spreadsheet

ASMITA_lite manual v1.0.doc

14

Feb 2010

ASMITA_lite MANUAL

Note: Under Setup → Time Step there is an option to include the user defined changes in the model
run, allowing the model to be run with and without the changes. The change data can therefore be
loaded when setting up the model and included when needed. However, only one change data set can
be loaded at any one time.
5.2 Element
Six different types of element can be specified and for each element a number of properties have to be
specified. In addition, if the model contains more than one element then the linkages and exchanges
between elements has to be specified. This can all be done via the user interface, using either the drop
down menu, or, once elements have been created, by right clicking the mouse on the edge of the
element box and selecting an option from the pop-up menu.
Note: Selecting elements can be a bit ticklish. Clicking the mouse just inside the top right corner is
the most effective.
The process of defining, specifying and deleting is described in the following sections followed by a
section explaining the definition of the element properties in more detail.
5.2.1
Define
To define an element the user must select the Setup → Element → Define item from the drop down
menu item, then use the mouse to draw a rectangle in the ASMITA model window (there is no prompt
to do this). To draw (define) the element, select the position of the top right hand corner. Whilst
holding down the left mouse button, drag the mouse until you have reached the desired size for the
element (rectangle). Figure 16 illustrates this concept.
Note: The size of the rectangle drawn plays no part in the calculation, the rectangle only represents
the schematisation of the environment under investigation.
No overlapping of elements is allowed, and no more than 30 elements can be specified in the current
version (Version 1.5). It is recommended that the user define at least two elements and that the user
allow for a suitable gap between elements, this ensures easier selection of elements.
Note: The order of the elements specified by the user determines the order in which they are stored
within the ASMITA model data structures. It is worth planning out the layout and sequence of the
model elements before setting-up the model as a well defined order to the elements can make the
subsequent definition of linkages easier. However the user can give each element a text name as part
of the Element Properties definition.
5.2.2
Specify
To enter element properties or define linkages either select Setup → Element → Specify from the
main menu, or right clicking on the element. The user can then select options from the pop-up menu
for Properties, Flow, Diffusion and Flats.
(i) Properties
Select Setup → Element → Specify → Properties from the menu and then left click on the element
to be edited, or right click on the element and selecting Properties from the pop-up menu. The
selected element will be highlighted and the Individual Element Specification window will be opened
(Figure 17).
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Figure 16

Steps to define a new element

Drag mouse to define
position of element

New Element

Exchange
properties

‘Name’

Figure 17

‘Type’

GUI for Specification of Element Properties
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(ii) Flow
To establish the dynamic exchange between elements any flows of diffusive exchanges have to be
defined. These can either be from one element to another and to or from the element to the
surrounding environment. In order to specify a flow, either left click on the element to be edited and
then select Setup → Element → Specify → Flow, or right click on the element and select Flow from
the pop-up menu. A pop-up is displayed prompting the user to click on the element that the flow is
going into (Figure 18). Once this has been selected the pop-up window details the elements that the
flow is from and to and allows the input a flow value in m3s-1 (Figure 19).
Figure 18

Initial pop-up to define flow prompting user to click on destination
element

Figure 19

Pop-ups to define flow from one element to another
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To specify flow from an Element to Environment, the user should follow the method above but
rather than selecting a second element, should click outside all of the elements displayed in the
ASMITA interface (Outside environment).
To select flow from the Environment to Element the user has to access the Flow method from the
main menu drop down list. The user should select Setup → Element → Specify → Flow and then
mouse click on the Outside Environment (outside all elements). The user is then prompted to select
the element in which flow will enter from the outside world (pop-up similar to Figure 18).
(iii) Diffusion
The process for defining diffusion between elements is similar to the definition of flows. As with
Flow, one can either right click to select an element and select Diffusion from the popup window, or
left click to select an element and access the same utility using Setup → Element → Specify →
Diffusion. Popup windows guide the user to select elements and enter diffusion rates. However,
diffusion is non-directional and so the order in which elements or the Outside Environment are
selected does not matter.
5.2.3
Resize
This option is only available from the pop-up menu that appears when the mouse is used to right click
on an element. Having selected Resize from the menu the user then uses the mouse to define a new
box and the existing element should move to the new location. However, if the new box is too close
to any other existing element box in the window, the box is not moved and the user will need to
reselect the option by right clicking on the element to be resized or moved.
5.2.4
Delete
To delete an element select Setup → Element → Delete from the menu and then left click on the
element to be deleted. The selected element will be highlighted and a popup window will appear
asking the user to confirm this action. Click yes to permanently delete the selected element.
Alternatively, elements can also be deleted by right clicking on the element and selecting Delete from
the pop-up menu.
5.2.5
Defining Element Properties
A number of properties have to be specified for each element. As explained above (Section 5.2.2(i)),
the GUI is accessed using the main menu option Setup → Element → Specify → Properties and
using the mouse to select an element. Tool tips for the Element properties provide a brief definition,
or advice on default values, and are displayed when the user hovers over a specific entry field.
To begin, the ‘Type’ of element has to be selected from the drop down list. There are six types of
element currently available:
Channel

Water volume below MLW and area at MLW.
Can be linked to coast, delta, flat, storage and other channel elements.

Coast

Dummy element to allow the inclusion of exchanges alongshore.
Can be linked to delta and channel elements.

Delta

Water volume over delta (where the delta has a volume relative to undisturbed
coastal bed). Can also use this element type to represent delta flats.
Can be linked to channel, coast and other delta elements.

Flat

Water volume between MLW and MHW over flats (ie not including the prism over
the channel) and area over flats. Flats on both sides of channel in a given reach can
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be included in a single flat element.
Can be linked to channel, saltmarsh and storage elements. Flats can also be linked
to adjacent along-channel flat elements for diffusion and advective exchanges but
multiple flat elements linked to the same channel element are not allowed.
Storage

Water volume and area of storage unit. Treated as locally independent of system
(not dependent on upstream prism) but contributing to downstream prism.
Can be linked to a channel or a flat element.
In addition the user can give a Name to each element. This is used as a label in the output file and for
plots and can be used to distinguish different branches or reaches as well as the type of element.
The other properties included in the GUI (Figure 17) are defined in Table 1 and further discussion of
how to set some of the sediment properties is provided in Section 8.
Table 1

Definition of Element Properties

Property
Initial Volume (m3)

Description
The water volume of the element at the start of the simulation

Initial Area (m2)

The surface area of the element at the start of the simulation

Tidal Range (m)

A tidal range is specified in the System Properties GUI which is used as
the ‘whole’ system value. The value entered here allows the tidal range
to be varied for individual reaches of the estuary. This allows tidal
amplification and damping to be taken into account.
Notes:
(i) there is no consistency check to ensure elements in the same reach
have the same tidal range. The calculation of the tidal prism and high
water volume both use only the values specified for channel elements.
However, the ‘equilibrium profile’ option (see below) uses thevalues
specified for the tidal flat elements If saltmarsh elements are included
the calculation of concentration over the marsh uses the tidal range
specified for the marsh element. It therefore best to ensure that these
values are consistent within any given reach.
(ii) the amplitude of cycles that alter the tidal range (Figure 11) are
scaled based on the ratio of the element specific tidal range to the
system tidal range.

Bed Slope (1:mb)

This is the transverse (cross-shore) slope of the element at its upper
boundary (low water for a channel element; with water or toe of marsh
for flat element and high water for a marsh element). The value mb is
the horizontal distance for a 1m vertical change.

Element Length (m)

The along-estuary length of the element.
Note: Although channel, flat and marsh elements in a given reach can
have different lengths, a change in area in one element is assumed to
give rise to an equivalent change in the adjacent element. So if the
channel expands in area, this area is removed from the low water
boundary of the tidal flat. Consequently if the elements are of different
lengths this can give rise to unrealistic changes.

Number of banks

In general a reach will have two banks and although only a single flat
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Property

Description
and marsh is associated with each channel this is presumed to represent
both banks. Hence the default value is two. However, when using the
equilibrium profile option (see below) it is possible to draw the
distinction between a symmetric channel (nbk = 2) and a half channel
with only one intertidal (nbk = 1). This can be useful where the
intertidal has been reclaimed on one side of the channel. It can also be
used to divide the estuary in two and represent each bank separately
(see case studies).

Import Density (kg.m-3)

The density of sediment contained in any advective flow that is an input
to the model.

Bulk Bed Density (kg.m-3)

The density of the bed is used to take account of the consolidation of
sediments on the bed.

Transport Coefficient

This coefficient represents the dominant mode of transport. If over the
long-term the model is considered to represent a diffusion process, this
would have a value of 2. Where advective transport (such as fluvial
import dominates) then a value of 5 based on bed load transport may be
more representative or a value of 3 where suspended load transport
dominates sediment exchanges.

Vertical Exchange (m.s-1)

This is the rate at which sediment is deposited on the bed of the
element. As this is a long-term model it is not strictly the sediment
settling velocity but this does provide a useful initial estimate of a
suitable value.
Equilibrium coefficient for volume: kv = Ve/Vp where Ve is the
equilibrium volume and Vp is the tidal prism. See below for options.

Coefficient k(Vp)
Coefficient k(Sp)

Equilibrium coefficient for surface area: ks = Se/Sp where Se is the
equilibrium surface area, Sp = Vp/tr, Vp is the tidal prism and tr is the
tidal range. See below for options.

Constrain change

Check box to set flag to constrain change so that element only in-fills.
Only applies to channel and flat elements. Used to represent hard
geology.

Note: See (Wang et al. 2007) for a discussion on model parameter setting and the interdependence
of the global equilibrium concentration, horizontal and vertical exchange rates and the transport
coefficient.
A unique value of kv and ks between 0 and 0.99 can be specified for each element using the input
boxes ‘Coefficient k(Vp)’ and ‘Coefficient k(Sp)’. Consequently different values can be used to
represent channel and flat equilibrium conditions. When a delta element is included, the delta
equations are also multiplied by kv and ks, so they can be used to re-scale the delta equilibrium
equations.
However, the values can also be set to force the model to calculate the equilibrium conditions and
there are currently three options available which are enabled by setting ‘Coefficient k(Vp)’ for ALL
elements to a value of 1, 2 or 3 (The values defined for ‘Coefficient k(Sp)’ are then ignored).
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Note: this is most easily changed from the command line of the Matlab interface by using the
following command:
>> for i=1:nelmax ELPROP{i}.kVp = ‘N’; end
where N is the value 1, 2 or 3.
K(Vp)
1
2

Initial conditions used to calculate ratios of the volume of the element and the tidal prism,
and the ratio of the surface area and prism/tidal range.
Initial conditions used to derive the equilibrium profile of an ‘average’ cross-section for
each reach, from which estimates of volume and surface area are made for the channel, flat
and marsh. The default is for these estimates to be scaled to the initial values, to provide a
scaling coefficient which is used to ‘correct’ the equilibrium estimates based on this
theoretical model (ie kv =Vo/Veq, etc). By setting ‘Coefficient k(Sp)’ for all elements to a
value of ‘0’, the equilibrium model values are used without scaling.

The models used in each of the two options are described in Appendix IV.
5.3 Time Step
To access the time step configuration window select Setup → Time Step from the main menu drop
down list. Tool tips for the Time Step properties provide a brief definition, or advice on default
values, and are displayed when the user hovers over a specific entry field.
Figure 20

Form to set run-time variables

Sets the calculation interval in years or parts of a year. Some model set ups can be quite sensitive to
the time step and if the results suggest some form of
instability it is worth trying a smaller time steps. This
may be particularly needed if the elements are
substantially different in size.
No of time steps x time step determines the duration of
the simulation.
The start year provides a point of reference for
introducing changes (see Section 5.1.3).
Output interval allows the output to be sub-sampled (eg
if running the model with a 0.25 year time step, a value
of 4 produces annual output)
Various options can be enabled for inclusion in the run
by checking the box alongside each option.

The model run duration is for the no. of Time Steps x
the Step Size, starting at the Start Year. So for the
values shown in Figure 20, the model will run from
1500 at half yearly intervals until 2060.
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Note: When using the model to hindcast historical periods including the influence of sea level rise, it
is important to remember that the model has a lag in its response to the initial onset of sea level rise
(at the beginning of the model simulation) and it will take some years to reach a steady state response
based on the morphological time scale of the system. For small estuaries this may only be a few
decades but for large systems can be several centuries.
5.3.1
Options
A number of check boxes are provided on the Configure Time Step form which operate as follows:
Equilibrium includes flow

If all external inputs area assigned the global equilibrium sediment
concentration then the basis for computing equilibrium is unaltered.
However, it is often desirable to include river inflows with their
associated sediment load. This would then be interpreted as a
perturbation to the system and the volumes and areas would be
adjusted accordingly. However, where initial values are used to
define the equilibrium coefficients (see Section 5.2.5 and Appendix
IV) it is implicit that the initial condition is being defined as an
equilibrium state. This option corrects for this by calculating an
offset based on the initial conditions and the defined flow
conditions. See Appendix VI for further details of the method used.

Include user defined changes

This option allows the user to include imposed Changes to the
system, such as dredging and reclamation. See Section 5.1.3 for
details of how to enter this information. The Changes are only
included in the model simulation if this option is checked.

Include tidal pumping

For multi-element models representing large systems with relatively
low sediment concentrations towards the mouth and a turbidity
maxima at some distance up-estuary, a more appropriate
representation can be achieved by including the influence of tidal
pumping. Checking this option includes tidal pumping. See
Appendix VI for further details of the method used.
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6
RUN MENU
After defining the individual elements and assigning the element and system properties the user has
the option to check the input data and run the ASMITA model.
6.1

Check Input

The Check Input function checks all data entered to ensure consistency. The diagnostic information
is reported back to the Matlab command window (Figure 21), a dialog box will also appear if all
values specified with ASMITA are correct. Note the Check Input function is called when the user
chooses the Run Model option. However, it might be more convenient to establish the model setup
without actually running ASMITA, in this circumstance the user should select the Check Input
function. Missing or inconsistent values will be reported to the user who will then be able to address
these errors. To access the Check Input function the user should select Run → Check Input from
the main menu drop down items.
Figure 21.

The Matlab command window where the diagnostic information is
reported back to the user

Diagnostic
information

6.2

Run Model

To run the ASMITA model the user should select Run → Run Model from the main menu drop
down list. Before the model run is initiated, the user is prompted for a file name with NO extension.
As the program runs a progress bar is displayed.
6.3

Model Output

ASMITA produces two output files. One is a text file with the setup information and the second is a
Microsoft Excel file. The Excel file contains a full set of model results, as well as a summary of all
the information used in the model configuration used for that run. The name of both the text and Excel
files are identical, except for the file extension.
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The model output includes the following parameters:
Moving Surface Volume
(vm)

The volume below a water level that may rise and fall over the
simulation period depending on the input parameters e.g. climate
change, nodal cycle and so on 1 . The moving surface volume describes
the combined morphological and water level change in the element

Equilibrium Volume
(ve)

This depends on the formulation used to define the equilibrium
condition (see Appendix) but is typically some function of the tidal
prism. The equilibrium volume describes the volume that the element
will try to adjust towards at any given point in time1.

Fixed Surface Volume
(cf)

The volume below a fixed water level defined by the water level at the
start of the simulation1. The change in volume represents the
morphological change in the element below the level of the fixed
surface.

Tidal Prism Volume
(vp)

The is the tidal prism assigned to each element at each time step.
Where a channel, flat and saltmarsh elements are linked to define a
given reach of the system, they will have the same tidal prism.

Tidal Range
(tr)

For simulations which only include sea level rise or forced
perturbations, this will be constant. Where a variation in tidal range is
included (eg nodal tidal cycle) this will show the tidal range used in
element (note if element specific values are not specified this will use
the value specified at the estuary mouth on the System → Water
Level properties input form.

Sediment Concentration
The local equilibrium sediment concentration for each element.
(cn)
Note: labels in parenthesis (eg. vm) are the worksheet tab names in the Excel spreadsheet output file.
The output parameters from the ASMITA model can be used to inform such things as:
• How elements change over time, responding to perturbations (eg dredging and reclamations) or
ongoing changes (eg sea level rise and changes in tidal range).
• The response in a moving frame of reference (moving surface) and fixed frame of reference (fixed
surface).
• The morphological phase lag and damping, based on the differences between the moving and
equilibrium values.

This will be a wet/water volume if the transport coefficient for the element is positive, otherwise it will be a dry/sediment
volume

1
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7
PLOT MENU
In order to visualise the results generated by the ASMITA model select Plot → Plot Results from the
drop down menu. Plot parameters are then selected from the Plot Element Specification interface
(Figure 22).
There are no limits as to the number of plot windows, the user can clear individual windows by
clicking on the cross in the top right hand corner. The user can select to clear all plot windows by
selecting the Tools → Clear → Clear Model function on the drop down menu. The plotting routines
will not allow identical parameters for the same element to be plotted on the same figure. By design,
selected parameters will be added to the current figure.
Figure 22

User interface for the generation of plots of the model results

Choose between elements
defined in ASMITA model

Option to display selected
variables: volume, depth,
etc

Option to plot variable as
absolute, relative or scaled
values

The user can create a new
plot or add to an existing
figure. The user can delete
data from a current plot
figure

A typical example of the output from ASMITA is displayed in Figure 23. The user can access this
data either from the saved Excel spreadsheet, or through the Matlab environment while the main
ASMITA window remains open.
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Figure 23

Example of results plot generated using ASMITA

Figure 24

Example of model results taken from output Excel spreadsheet and
plotted against historic data
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8

MODEL SET-UP

8.1 Element Definition
Decide how the estuary or tidal inlet should be sub-divided. This will usually involve a number of
channel elements with associated tidal flat elements. In addition, there may be a need to include a
tidal delta and any tidal flats associated with the delta.. As far as possible it is worth trying to
examine the constraints on the system (geology, sediment sources, sea walls, etc), as a basis for
identifying “reaches” that are likely to have a consistent internal behaviour. It is also better to avoid
very large differences in the size of elements (several orders of magnitude), as this can give problems
in some of the matrix calculations.
Sometimes it is useful to set up a whole estuary model (comprising just a channel and tidal flats, or
delta, channel and tidal flats) to get a feel for the overall behaviour of the system, prior to developing
a more detailed representation. However, if river inflows with a sediment load are to be included, it
should be noted that the response of a “single” channel element model, will be different to a multielement model. As a consequence, it is sometimes better to ignore the river inflows for the single
channel element case.
A range of different model configurations are described in Section 9, to illustrate some of the possible
ways in which different types of element can be combined.
To set up multi element channels
o Define Seaward element in System/Properties as the id of the most seaward channel element.
If a delta is included, this value is not used and the program uses the link between delta and
channel element to define the most seaward element. Channel elements can branch and the
cumulative prism includes all upstream branches of any given channel element.
o Each channel element can have a flat a marsh and multiple storage elements. Storage
elements are included in the calculation of tidal prism but not in the area and volumes at high
water used to determine constraints (ie storage elements are considered outwith the estuary
system).
o Channels and flats can be linked by diffusion and advection.
To set up multiple tidal inlets.
o Define Seaward element as 0 in System/Properties
o Each inlet can have a delta, channel, flat, saltmarsh and multiple storage elements. Storage
elements are included in the calculation of tidal prism but not in the area and volumes at high
water used to determine constraints (ie storage elements are considered outwith the estuary
system).
o Channels and flats can be linked by diffusion and advection
8.2 System Specification
The global equilibrium concentration is one of the main calibration parameters. One option is to use
the seasonally averaged mean value of suspended sediment concentration as an initial estimate. (For
the Humber this is 720mg.l-1, which as a volume concentration equates to cE=2.7x10-4, a value not
dissimilar to the value proposed by w/|delft for Estmorf of cE=2.0x10-4). Where tidal pumping is
included some experimentation will be needed to define the global equilibrium concentration that
generates realistic concentration gradients within the estuary. In theory, this should reflect the longterm average concentrations at the marine boundary but again may need to be adjusted to give
realistic values within the estuary.
.
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8.3 Water level Specification
Define the tidal range for the estuary as a whole (value at mouth). For large systems divided into
multiple elements, the tidal range can be defined separately for each element. As a default the system
value is used if element specific values are not defined.
The rate of sea level rise, can be specified as a constant linear rate or an exponential function. Details
of how to define the rate of sea level rise are given in Section 5.1.2.
The model allows variations to the tidal range to be included. For each cycle included, the amplitude,
period and phase need to be specified. The most readily identifiable cycle is the nodal tidal cycle
which is given by:
Amplitude = 3.8% of tidal range; period = 18.6 years, phase = 12.2 years.
In work on longer-term changes, a long-term cycle be relevant, such as the one defined based on
studies on the Humber (Townend et al. 2007) and defined as follows:
Amplitude = 0.05m; period = 180years, phase = 128 years.
This provides an increase in tidal range of ~1mm/year in phase with what was observed over the 20th
century.
8.4 Element Specification
Using a suitable DGM the volumes and areas can be calculated in one of two ways:
(i)
Define a horizontal plane at high and low water level and calculate the water volumes below
the plane and the surface areas on the planes.
(ii) Use the surfaces for high and low water derived from a hydraulic model in conjunction with a
DGM to calculate the water volumes below the surface and the surface areas at high and low
water. This added complexity is not needed for small or relatively short estuaries but can be
important for longer estuaries that are near resonant (Thames, Humber, Severn, etc).
Note: the HTA toolkit, developed in Matlab as part of FD2107, provides the tools to rapidly generate
the required volumes and areas, for each element, using either of the above methods.
It is also possible to define elements as sediment volumes rather than wet volumes. If this is
preferred, then the sediment transport coefficient, n, should be expressed as a negative value. This
was the basis for the original model development which used fixed surface areas (Stive et al. 1998;
Kragtwijk et al. 2004) and works for this form of configuration.
The same DGM can be used to obtain the average cross-shore slope at high and low water within each
element.
The tidal range can be specified for each element. This is useful for large systems with significant
along estuary variation and can be derived using the output from a hydraulic model by averaging the
tidal range over the length of each element. The tidal flat associated with a given channel element is
assumed to have the same tidal range (for the internal calculation of tidal prism) but there is no check
for this within the code.
The concentration imported by advection is the sediment load associated with any inflows to the
element (see Section 8.6 for fuller explanation).
The bulk density of sediment relates to the density of the bed within the element. This is included to
take account of the consolidation of sediment that is deposited and is used in the code to adjust the
vertical rate of exchange. The default value of 1350kg.m-3 is typical for many UK estuaries.
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The sediment transport coefficient reflects the nature of the transport process. For simple diffusion a
value of 2 can be adopted. Where suspended or bed load transport dominate a value between 3 and 5
may be more appropriate. As this model is considering long-term evolution it can be argued that the
process can be treated as essentially diffusive, suggesting a value of 2. Furthermore, it is the product
of n and cE that determines the morphological response time, so that using a set value may simply
result in a slightly different value of cE.
The vertical exchange (although not strictly a sediment fall velocity) should be based on the fall
velocity for the sediment type that characterises most of the element. There is an inter-dependence
between the fall velocity and the horizontal exchange which is explained further in the Section on
Diffusion.
8.5 Diffusion
The spreadsheet ‘Blank Model Paramenters.xls’ is available to help define the values to be used for
horizontal exchange.
8.5.1
Exchange between channel elements (and channel and delta)
The horizontal diffusion coefficient is related to the vertical exchange by the relationship:

D
u
=ε
uh
ws

(1)

where u is the velocity (at mtl or peak) between two channel elements, h is the hydraulic depth
(assumed to be at mtl) and ws is the vertical exchange. The basis of this equality is explained in Wang
et al. (2007), where the parameter ε is a coefficient of proportionality, which is suggested as a
calibration coefficient of order 0.1. Given the uncertainty in defining the horizontal exchange
coefficient, as set out below, the coefficient is taken to be unity and accounted for by simply adjusting
the horizontal exchange values directly.
For use within ASMITA, this has to be expressed as a horizontal rate of exchange between elements,
given by:
δ = D.A/Lx
(2)
where A is the cross-sectional area between the elements and Lx is the distance between the two
elements. However, this is rather dependent on how the elements happen to be defined and a better
way of determining Lx is to use the tidal excursion distance given by:
Lx = up.TP/π
(3)
where up is the peak velocity and TP is the tidal period in seconds and simply assumes a sinusoidal
variation in velocity over the tidal cycle. Model output can be used to define the excursion, if
available.
8.5.2
Exchange between channel and flats
Three methods have been used to-date for estimating the exchange between channel and flats.
(i)

Use the channel estimate of δ, equation (2), and replace the csa, A ,with the Aint, given by:
Aint = LR.tr/2

(4)

where LR is the length of the element (reach) and tr is the tidal range. The half makes this an average
value based on the variation between high and low water.
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(ii)

Use equation (1) with the hydraulic depth based on the values for the tidal flat (note: this can be
estimated using hfl = Vfl/Sfl). Then obtain δ from equation (2), with the value of A defined by
Aint as given in equation (4).

(iii)

Use the rate of propagation across the tidal flat to estimate the transverse velocity:
ufl = π.Wfl /(nbk .TP)

(5)

where Wfl is the average width of the tidal flats and can be estimated from Sfl/LR and nbk is the number
of banks with flats associated with the width, Wfl. Then use equation (1) with hfl and ufl to obtain Dfl.
The horizontal exchange onto the flat is then given by a modified form of equation (2):
δfl = Dfl.Aint/Wfl
(6)
Experience to-date suggests that the third method is the most suitable but further work is needed to
establish which of these is the most appropriate.
8.6 Advection
The model provides for advective flows through the system. Necessarily the flow in and out of an
element must sum to zero and the code checks for this. The use of this facility is typically to include
one or more river flows into the system. If a flow is introduced into the upstream channel then this
must be propagated through each of the downstream channel elements to the open sea boundary. (For
a single linear channel system, this means there should be the same flow in and out of each element).
Each inflow to the system can however, have a different sediment load. This is specified as the
concentration imported by advection within the Element Specification, expressed as a concentration
density (kg.m-3) and an estimate can usually be obtained from measured data of the riverine input.
It is important to recognise that the model is seeking to impose an equilibrium concentration over the
system as a whole, as the basis for volumetric equilibrium. This is why the option to take account of
the flow in the definition of the equilibrium condition can be included by checking the box on the
Configure Time Step GUI, Figure 20. (The basis of the flow adjustment to the equilibrium condition
is explained in Appendix VI). If this option is not checked the flow conditions are in effect a
perturbation to the system. This magnitude of this influence can be explored by setting all other
changes (forced changes, transgression, slr and tidal range) to zero and running the model with and
without this box checked. When the ‘Equilibrium includes Flow’ option is selected the element
volumes should remain constant. When it is not selected the response will depend on the model
configuration.
For a single (channel) element model a concentration associated with advective flow through the
element, that is less than cE , will give rise to net export from the system. This is because the
advective flow out of the element is removing sediment at the concentration of cE, whereas the inflow
is only replacing this at the lower rate. The converse is obviously the case when the concentration of
the inflow is larger, resulting in net import. It also follows that a value that is equal to cE is equivalent
to the no flow case.
For a multi-element definition of the channel, this is no longer the case, providing the diffusion
between channel elements varies, and there are two or more channel elements, the element connected
to the river inflow will adjust according to the exchange with the downstream element and this is
distinct from the exchange of the last element that is connected to the open sea environment. The
system can therefore co-adjust to take account of the different concentrations at the respective
boundaries.

ASMITA_lite manual v1.0.doc

30

Feb 2010

ASMITA_lite MANUAL
8.7 Forced Changes
Changes introduced by developments on an estuary can be represented as perturbations to the system
at a given time step, or over a defined time interval. This might be useful to represent a capital dredge
and the subsequent maintenance dredging as a series of volume changes in the relevant channel
elements. If the dredging impacts on the tidal flats then associated changes in the areas of the flat and
channel elements may also need to be defined. Similarly, a reclamation could be defined as a loss of
volume and area (usually on the tidal flats). These changes are all defined in a Change spreadsheet
and then loaded into the model as explained in Section 5.1.3.
8.8 Storage
Storage areas are independent of the main channel network and can be linked to channel or flat
elements. The volume of water exchanged contributes to the downstream prism of the estuary but the
estuary does not influence the storage element, other than controlling the rate of sediment supply.
The basis for defining equilibrium of this type of sub-system is poorly defined and needs further
development. The option currently available uses the ratio of volume and area of the storage element
to the prism of the element.
8.9 Known Instabilities
The potential complexity of the model and the various options that can be selected means that it is
possible to configure a model that is unstable in some way.
(i)
Time Step
For models with very different sized elements, when a marsh is included, or a nodal tidal cycle is
introduced, the model time step can become critical. This often generates output that looks to be
chaotic and at the moment there is no internal check. In general, this can be cured by reducing the
size of the time step but it may also be necessary to consider the element bed slope, particularly at
high water (ie in the marsh and flat elements) if variable area is included in the model.
(ii)
Channel elements infill
When an elements area or volume goes to zero, a warning is displayed in the Matlab command
window. If any of these elements is a channel element then the model stops running. This
reflects the model parameterisation and suggests that, for the given schemetisation, there is an
imbalance in the way the model is configured. There can be a number of reasons for this and
finding a solution usually involves exploring other parameter settings. For example the Wallasea
model ran without problems for the sea level rise case but then stopped because a channel element
infilled when the nodal tide was introduced. (Note: introducing a small cyclic signal is a good
test of whether the parameter settings are robust). This was solved, in this case, by reducing the
horizontal exchange between elements 7 and 9 and the associated flat (Figure 31).
It is often worth checking that it is not something related to the constraints by running the model
first with fixed area and then with fixed area at HW. If these configuration are stable then it may
be that the element bed slopes, particularly for flats and marshes need to be re-considered.
Altering the time step may also reduce model sensitivity, particularly if large perturbations are
being introduced. This is particularly apparent when tidal pumping is included in a multi-element
model. Another possible cause is a poorly specified balance of exchanges between elements and
experimenting with different horizontal diffusion between elements, or changing the load
associated with inputs (eg river sediment flux) may reveal particular sensitivities and so lead to a
resolution of the problem. It is important to remember that the model is based on a simplified
representation of the geomorphological components that make up an estuary and that exact
representation of local detail is inappropriate. The aim is to simulate the large scale behaviour of
the overall changes in volume and area.
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9

EXAMPLE MODEL CONFIGURATIONS
9.1

Simple models

The set-up and a typical output for the Humber 2EM model is shown in Figure 25. The run shown
includes the changes defined in ‘Change.xls’, which defines a reclamation on the flats in 1900 and a
capital dredge of the channel in 1960 followed by 16 years of maintenance dredging.
Figure 25

Model set up for Humber 2EM and sample output including forced
changes

The Humber 2EM+store model includes an area representative of a managed realignment but is
otherwise similar to the basic model. By adjusting the values of k(Vp) and k(Sp) different
equilibrium conditions can be applied (see Section 5.2.5 and 8.8). The present model assumes that the
total area of the storage area is fixed. Given that managed realignment sites are unlikely to represent
an equilibrium condition, one option available is to use the CKFA model, representing the storage
element as a tidal inlet. However, this is an area where more basic research is needed and this and the
other options should be used with due care and extensive sensitivity testing.
Figure 26

Model set-up for 2EM+delta.
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The model is also able to represent alongshore “flows” by including ‘coast’ elements either side of a
‘delta’ element, as illustrated in Figure 26. The alongshore drift is included by specifying a flow rate
in to and out of the updrift and downdrift coast elements with an associated import sediment
concentration defined for the updrift coast element. The load passing through coast and downdrift
will be determined by the model based on the concentration in the downdrift coast element. The
sample file also includes the river flow so that the interaction between fluvial and alongshore
exchanges can be explored. Note: the model is illustrative only, and has not been set-up and tested
against real data for the alongshore conditions.
9.2 Multi-element single channel model of the Humber Estuary
A much more detailed model of the Humber is provided in the file ‘Humber 7 1.mat’. This contains a
total of 14 elements. There are 5 channel elements representing the main estuary, with a river channel
element and a delta element at either end. Each channel element has an associated flat element,
although this the tidal flat linked to the delta “channel” is represented as another ‘delta’ element. This
allows for an exchange between the sub-tidal delta element and the intertidal delta element based on
the defined vertical exchange but means that equilibrium is defined by tidal prism ratios in both cases
whatever equilibrium option is selected. (If the intertidal part of the delta were to be included as a flat
element, this would impose the idealised intertidal profile onto this element with some of the
equilibrium options – ie. k(Vp)=2 or 3).
This model is also set-up with the parameters needed to include tidal pumping which can be included
by checking the relevant box on the Configure Time Step GUI, Figure 20. The outputs shown in
Figure 24 were obtained using this model (without tidal pumping and with cE=0.72) and summing
the volume change for the channel elements 1-5 and similarly the tidal flat surface areas for flat
elements 6-10.

Figure 27

14 element model of Humber with 6 channel and flat elements plus two
delta elements
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9.3 Multi-element model with two-sided flats in Southampton Water
When there is a need to consider how individual tidal flats will evolve or if there is a distinct
asymmetry in the estuary that is to be represented, then one way of doing this is to split the channels
in two. This is nicely illustrated in the case of Southampton Water. Both the Itchen and the Test are
effectively one sided channels because one bank has been extensively reclaimed to form a series of
wharfs and quays. In addition, the northerly Western Shore is quite distinct from the Hythe Shore on
the more southerly side of Southampton Water (SW in Figure 28). The outer part of Southampton
Water and the Hamble more closely resemble two sided channel/flat systems.
The approach adopted in the representation shown in Figure 28 is to:
(i)
(ii)
(iii)
(iv)

represent the Test and Itchen as one-sided channel/flat systems;
divide Southampton Water into two distinct one-sided channel flat systems, roughly in
proportion to the upstream tributaries and connect the south side to the Test and the north
side to the Itchen;
add the Hamble as a conventional two-sided channel/flat system; and
connect the Hamble channel and the two Southampton Water channels to an Outer
channel which is two-sided with an accompanying two-sided flat.

The resulting model is provided in ‘Southampton Water 2shore.mat’ and there is also an example
parameter file in ‘SW 2shore model parameters.xls’.
Figure 28

Southampton Water model with channel network and combination of
one and two sided channel and flat elements

9.4 Multi-inlet model of Venice Lagoon
Single inlets can be modelled as multi-element systems, much as estuaries. However, where there is
more than one inlet mouth and the inlets exchange flow internally, then model set-up is restricted to a
single channel, flat and marsh per inlet mouth. Examples of this are the Chichester, Langston and
Portsmouth harbours on the south coast of the UK and Venice Lagoon. The only other requirement
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when setting-up this type of configuration, is to set the ‘Seaward Element’ to zero on the System
Properties GUI (Figure 10).
The example shown in Figure 29 is for Venice Lagoon. This includes some relatively small river
inflows into each channel element and exchanges between the channels of each inlet. This examples
also has individual predefined ratios for the equilibrium ratios for the volume and surface area, as a
proportion of the tidal prism. (The inclusion of saltmarsh requires the full version of ASMITA).
Figure 29

9.5

9 element model Venice Lagoon with a channel, flat and marsh element
for each inlet

Multi-element branching channel with storage areas included, to represent managed
realignment on Wallasea Island.

This application illustrates a number of aspects of model configuration. In representing the existing
estuary of the Crouch-Roach a branching network was defined, as illustrated in Figure 30. In this
case marshes were not included and every channel was associated with a single flat element, which
represented both banks. The model is very sensitive to the horizontal exchanges to elements 9 and 10,
particularly when a nodal tide is introduced. This is possibly because these two elements are much
smaller than the others and the problem was overcome by reducing the horizontal exchange
coefficients.
The managed realignment schemes were then introduced as a series of storage areas connected to the
channel, Figure 31. (Storage areas can also be linked to flat element and a sensitivity test was run to
see to show that this made little difference to the impact on the rest of the system.)
Figure 30

12 element model of the existing Crouch-Roach estuary around
Wallasea Island. Comprises a network of 6 channel elements and
associated flats, with channel branching indicated by arrows.

ASMITA_lite manual v1.0.doc

35

Feb 2010

ASMITA_lite MANUAL

Figure 31

15 element model with Wallasea Island Managed Realignment schemes
added to baseline model. 3 storage elements connected to element 7.
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APPENDICES

Appendix I
I.1

Background to ASMITA model

Introduction

ASMITA (Aggregated Scale Morphological Interaction between a Tidal Basin and the Adjacent coast,
Stive et al. 1998) is an approach developed for the study of estuary response to sea level rise. The
model is based on an aggregated model that considers the estuary as a box (or set of boxes) that fills
and empties under tidal action. The methodology was developed to look at the combined response of
tidal delta, channel and tidal flats and has been applied to examine inlet response to human
interferences (Kragtwijk et al. 2004), sea level rise (van Goor et al. 2003) changes in tidal range and
the response of an estuary to the nodal tidal cycle (Jeuken et al. 2003).
This note summaries the basis of the ASMITA model, combining multiple elements with marine and
fluvial sources. In addition the existing ASMITA, which only considers variations in estuary volume,
is extended to represent time varying surface area. This allows perturbations to be introduced in the
form of changes to the volumes and areas due to interventions such as dredging and reclamation, as
well as sea level rise and cyclic variations in the tidal range. The basis of the empirical relationship
used to define the equilibrium relationships is also given some further consideration.

I.2

Single element volume model

For a single element model, comprising just an estuary channel, the equilibrium state is derived from
the equilibrium relationship assumed between the channel volume and the tidal prism:
Vce = f(P)

(I.1)

Where Vce is the equilibrium volume of the channel and P is the tidal prism (Eysink, 1990).
The other assumption made is that the ratio of the actual flow velocity to the equilibrium condition is
proportional to the ratio of the equilibrium volume and actual volume. The local equilibrium
concentration can therefore be written in terms of the actual volume, V, and the equilibrium volume,
Vce:

⎛V
c ce = c E ⎜ ce
⎜V
⎝

⎞
⎟
⎟
⎠

n

(I.2)

Here cce is the local equilibrium concentration, n is the concentration transport exponent and cE is the
equilibrium concentration for the system as a whole (usually taken as the open boundary value). The
difference between the actual concentration and the local equilibrium value induces morphological
change governed by the exchange between the water column and the bed:

dV
1
= wS (cce − c )
dt cb

(I.3)

Where w is the vertical exchange coefficient, S is the surface or plan area of the channel, c is the
actual concentration and cb is the concentration of the bed (omitted in original derivation). If we now
consider a sediment balance where the (long-term residual) sediment transport between elements is
assumed to be simply diffusive (in this case the channel and the external environment):

wS (c ce − c ) = δ co (c − c E )
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The parameter δco is the horizontal exchange coefficient and the r.h.s. of equation (I.4) represents the
exchange with the external environment.
Combining equations (I.2)-(I.4) and adopting a simple linear relationship for equation (I.1) of the
form Ve=αP, where α is an empirical coefficient, the morphological change in volume is given by:

dV 1 wδ cE S
= ⋅
dt cb δ + wS

⎡⎛ V (t ) ⎞ n ⎤
⎢⎜⎜ e ⎟⎟ − 1⎥
⎢⎣⎝ Vm (t ) ⎠
⎥⎦

(I.5)

This is a change relative to the initial volume and so does not include changes in water levels and tidal
range. It is therefore referred to as the fixed surface volume change, Vf. The equilibrium volume, Ve,
fixed surface volume, Vf, and the moving surface volume, Vm can be written:

Ve (t ) = α ⋅ P = Po + ΔP
dV
dt
dt
η
dV
⎛ dζ
⎞
Vm (t ) = Vm 0 + ∫
dt + ⎜
⋅ t + ⋅ eiωt ⎟ ⋅ S
dt
2
⎝ dt
⎠

V f (t ) = V f 0 + ∫

(I.6)

Where Vm includes the variation in volume due to sea level rise and some cyclic variation in tidal
range, such as the nodal tidal cycle. The variables in equations I.5 and I.6 are defined as follows:
Ve – equilibrium volume
Vm – moving surface volume
Vf – fixed surface volume
P – tidal prism
Po – initial prism at time t=0
α – volume to prism ratio

ζ – vertical sea level movement
ω – angular frequency of nodal tide
η – amplitude of nodal tide
S – surface area of basin
n – sediment transport exponent,
usually taken as ~2.

w – vertical exchange rate
δ – horizontal exchange rate
cE – global equilibrium
concentration
cb - bed concentration

In this simple model the plan area is treated as constant. On the basis that Ve ~ fn(P) any hydraulic
changes that result in a change in tidal prism are represented in Ve but those that change the volume of
the system (such as sea level rise, dredging or reclamation) are represented in Vm.
The variation in equilibrium, moving and fixed estuary volumes, due to a linear rise in sea level and
the nodal tidal cycle, are illustrated in Figure I.1. The lag and damping of the response, relative to the
equilibrium volume, is due to the dynamics associated with the morphological response time of the
estuary (Jeuken et al. 2003).
The reduction of the volume relative to a fixed surface, shown in Figure I.1, reflects the infilling of
the basin that takes place, in order for the morphology to “warp up” vertically to keep pace with sea
level rise (and the superimposed nodal cycle). Thus, vertical translation of the system is incorporated
in this model. If, however, we wish to include the possibility of horizontal translation, as well as the
vertical response, it is necessary to adjust the plan area rather than treat it as constant.
In this formulation, the morphological timescale is determined by n and cE. In addition, the horizontal
exchange is related to the vertical exchange as a function of hydraulic depth and velocity. This means
that by defining the vertical exchange, w, and the sediment transport exponent, n, based on the
sediment characteristics of the estuary, and the global equilibrium concentration, cE, to give the
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correct morphological time scale, the horizontal exchange coefficient is scaled by some factor, ε, to
calibrate the model (see Wang et al. 2007 for further details).
Figure I.1 – Variation in estuary volume for rising sea level and nodal tidal cycle as
predicted by the single element model

I.3

Morphological Response Time

Linearising equation (I.5) around the equilibrium, Kragtwijk et al (2004) show that the morphological
time scale can be expressed as:

τ=

V ⎞
1 ⎛ Ve
⎜⎜
+ e ⎟⎟
c E ⋅ n ⎝ ws ⋅ S δ ⎠

(I.7)

This makes clear that the morphological e-folding time scale (or half life) is a function of the system
properties but not the disturbance. This equation is derived for a single element model and so also
provides a response time scale for the system as a whole. For multiple elements, similar relationships
can be derived for the individual elements (see Kragtwijk et al for further details). Another useful
measure is proposed by van Goor et al (2003). They note that there is a permanent difference between
the equilibrium volume with SLR (Ve*) and the equilibrium volume without SLR (Ve). This
difference in equilibrium volume is necessary to maintain the demand of sediment that drives a
sediment import into the system to such extent that the system does not drown. They show that the
equilibrium volume with SLR Ve* becomes infinitely large when:

wδc
dζ
= s E
dt δ + ws S

I.4

(I.8)

Multi-element volume model

The basic concept of the multi-element model is to subdivide the estuary into a number of elements
and define the exchanges between elements and the equilibrium conditions for each element. As
already noted, this has been presented in the literature as the ASMITA model (Aggregated Scale
Morphological Interaction between a Tidal basin the Adjacent coast) and was introduced by Stive et al
(1998; see also van Goor et al. 2003; and Kragtwijk et al. 2004). The system can be schematised
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into any number of discrete elements, which might be sections along the channel as used in
ESTMORF (Wang et al. 1998), or geomorphological components, such as the channel and tidal flats
as typically used in ASMITA. This is illustrated in Figure 1, which shows the linkage between tidal
flat, channel and tidal delta through to the open sea, referred to as the outside world. For each
component the volume can be defined in terms of the sediment or water volume. In the derivation
presented here, only water volumes are used and the equations presented reflect this (for the more
general case see the papers noted above). So, for example, the scheme shown in Figure 1 would be
represented by:
Tidal delta Channel Tidal flats Marsh

-

Storage

-

total water volume over delta (where the delta has a volume relative to undisturbed
coastal bed)`
total water volume below MLW
total water volume between MLW and MHW over flats (ie not including the prism
over the channel)
total volume over the marsh (time average to MHW, noting that there will be greater
inundation at springs than during neaps)
total volume in the storage area. below MHW

The variation in these volumes depends on the transport of sediment in and out of the elements and
any changes to the water volume itself. The latter may be due to sea level rise, subsidence of the bed,
or any form of progressive change in the basin volume. Hence, over the long-term (time scales much
longer than a tidal cycle) the rate of change of the element volume depends on the residual flux, the
change in sea level as follows and any change in tidal range:

dVi
dζ
d (tr )
= ∑ J i, j + Si
+ Si
dt
dt
dt
j

(I.9)

where J is the sediment volume flux between elements i and j, S is the plan area of the element and ζ
is the elevation of mean sea level. The residual sediment flux between two elements is assumed to
have advective and diffusive components:

J i , j = qi , j ⋅ ci − q j ,i ⋅ c j + Di , j Ai , j

∂c
∂x

(I.10)

where q (m3s-1) is the residual discharge rate (qi,j ≠ qj,i), D (m2s-1) is the diffusion coefficient between
the two elements, A (m2) is the vertical area of the interface between the two elements and the sign
convention reflects the change to the water volume. This can be written in a form similar to the r.h.s.
of equation (I.4):

J i , j = qi , j ⋅ ci − q j ,i ⋅ c j + δ i , j ⋅ (ci − c j )

(I.11)

In equations (I.10) and (I.11) the subscripts i and j refer to the elements the transport is from and to
respectively. The advective component assumes that the concentration of the flux is that of the
element supplying the sediment, which is important for external inputs such as from the rivers. In
contrast the diffusive component simply uses the gradient between the elements.
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Appendix II

Matrix formulation

The equations presented for the single element model can be conveniently written in matrix form to
represent a multi-element model. Here we follow the naming convention of Kragtwijk et al (2004) for
volumes and add some additional terms to make the model more general with respect to diffusion,
advection and the sources of perturbations in the volume.
For a multi-element model the variables used in Appendix I are defined as either vectors or matrices,
as follows:
V

element volumes

γ

volume ratios (Vke /Vk)n

S

element surface areas

σ

surface area ratios (Ske /Sk)abs(n)

ce

local equilibrium concentrations

c

element concentrations

δ ext horizontal exchange coefficients with
environment

n

cext concentrations for fluxes into the system cb
from the environment

concentration transport exponent.
positive for wet volumes and negative
for sediment volumes
concentration of bed

qext Advective flows into the system from
the environment

Diagonal matrices:
D

horizontal exchange between elements

W vertical exchange coefficient w

Q

advective exchange between elements

S

surface areas

B

Expression to scale rate of change

I

unit or identity matrix

d

Expression for offset to rate of change

M unit matrix with sign of n

The matrix D reflects the structure of the horizontal exchange between elements and with the outside
world. For an n-element system with all elements linked and exchanging sediment with external
environments, this would take the following form:

⎛
⎜
⎜ ∑ δ1,n + δ1, E
− δ 2,1
D=⎜
⎜
⎜ ...
⎜ −δ
n ,1
⎝

− δ1, 2
∑ δ 2,n + δ 2, E
...
− δ n, 2

...
...
...
...

⎞
⎟
− δ1,n
⎟
⎟
− δ 2,n
⎟
...
⎟
∑ δ n,n + δ n,E ⎟⎠

(II.1)

For a 3-element system in which only element 3 is connected to the external environment (eg a tidal
flat, channel and delta) this would take the form:

⎛ δ1, 2
⎞
− δ1, 2
0
⎜
⎟
− δ 2,3 ⎟
D = ⎜ − δ 2,1 δ 2,1 + δ 2,3
⎜ 0
− δ 3, 2
δ 3, 2 + δ 3, E ⎟⎠
⎝

ASMITA_lite manual v1.0.doc

45

(II.2)

Feb 2010

ASMITA_lite MANUAL
For diffusion the matrix is symmetric because δi,j = δj,i and the direction of transport depends on the
concentration gradient. However, for advective transport the flow has a specified direction and as
already noted we adopt the convention of transport from element i to element j. The matrix for an nelement system is then given by:

⎛
⎜
⎜ ∑ q1,n + q1, E
− q2,1
Q=⎜
⎜
⎜ ...
⎜ −q
n ,1
⎝

− q1, 2
∑ q2 , n + q2 , E
...
− qn , 2

⎞
⎟
− q1,n
⎟
⎟
− q2 , n
⎟
...
⎟
∑ qn,n + qn,E ⎟⎠

...
...
...
...

(II.3)

Where qn,E all relate to fluxes out of the system. In order to ensure continuity of water mass we also
require that, for each element, the sum of the discharges in and out of the element is zero, ie Σ qi = 0.
However, provision is made for the sediment concentrations associated with these discharges to vary.
The basic equations can now be written:

dV 1
= MWS(ce − c)
dt cb

(

(D + QT )c = WS(ce − c) + cE δ ext + kc ⋅ qext
ce = cE γ

and kc =

cext

)

(II.4)

cE

The basis for calculating the change in volume due to some perturbation is then as follows:

dV 1
= (Bγ − d ) + ΔV
dt cb

where

(II.5)
−1

B = cE MWS(I − (D + Q + WS) WS)
T

d = cE MWS(D + QT + WS) −1 (δ ext + kc ⋅ qext )
The term ΔV refers to any other changes in volume, introduced at any given time, within each
element, eg due to reclamation or dredging. The change determined by equation (II.5) is the
morphological adjustment relative to the initial volume and so does not include changes in water
levels and tidal range but the volumes used in defining γ are based on the total water volume of the
element at any given time interval. As in Appendix I, these are referred to as Vf and Vm respectively.
When using the ratio of element volume to tidal prism as the basis for equilibrium, the equilibrium,
fixed and moving volumes are given by:

(

Ve = α ⋅ P = α ⋅ P0 + ΔP

)

dV
dt
dt
dV
⎛ dζ
⎞
Vm = Vm 0 + ∫
dt + ⎜
⋅ t + trs ⋅ δ tr ⎟ ⋅ S
dt
⎝ dt
⎠
Vf = Vf 0 + ∫

ASMITA_lite manual v1.0.doc

46

(II.6)

Feb 2010

ASMITA_lite MANUAL
where tr refers to the tidal range and δtr is the variation in the tidal range from its mean value. The
expression trs refers to multiplication by ½ with a sign that reflects whether the element is influenced
by high or low water.
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Appendix III
III.1

Other Enhancements to ASMITA

Advective flow equilibrium

The original developers of the ASMITA model assumed that the equilibrium of the elements within
the model domain was conditioned by the concentration in the “outside world” or external
environment. When considering a delta/channel/flat system, as in the original applications, this global
equilibrium is determined solely by the concentration in the “external” marine environment (ie a
single value). The condition for equilibrium then requires that the volume rate of change goes to zero
(equation I.3), which is equivalent to zero gradient in the concentration field. If other sources are
introduced, such as a river input, this remains the basis for equilibrium provided the concentration is
the same as the global concentration. However, if the concentration associated with the other sources
is not the same then equation (I.3) no longer represents an equilibrium state, or put another way, the
additional source constitutes a perturbation to the system. One way of overcoming this is to
determine the equilibrium taking account of the additional inputs, on the assumption that these are
intrinsic to the state of equilibrium represented by the initial state of the system being modelled. This
is predicated on the idea that the form of the estuary (bathymetry etc) used to describe the existing
state will be close to an equilibrium with the prevailing conditions and, consequently, the various
inputs must all be represented in this state.
For a single element the for of equations (I.3) with the inclusion of a river input is as follows:
n
⎧⎪
⎫⎪
dV
⎛V ⎞
= C ⎨(qo + δ e )⎜ e ⎟ − (qr + δ e )⎬
dt
⎪⎩
⎪⎭
⎝V ⎠

(VI.1)

Where q0 is discharge to the marine environment, qr is the river discharge and δe is the horizontal
exchange rate. In order to have a different concentration associated with the river flow but allow cE to
be factored into the coefficient C in equation (VI.1) the imported concentrations are expressed as
ci = ki .cE. With some re-arrangement it can be shown that dV/dt =>0 if the equilibrium volume is
factored by:

⎛ k ⋅ qr + δ E
α = ⎜⎜
⎝ qo + δ E

⎞
⎟⎟
⎠

1/ n

(VI.2)

The adjusted equilibrium is then given by:
n
⎧⎪
⎫⎪
dV
⎛ α ⋅ Ve ⎞
= C ⎨(q o + δ e )⎜
⎟ − (q r + δ e )⎬
dt
⎪⎩
⎪⎭
⎝ V ⎠

(VI.3)

This is addressed in ASMITA by allowing the user to select the ‘Include flow equilibrium’ option on
the Configure Time Step GUI, Figure 20. This is implemented in matrix form based on the initial
conditions as:

eqS = (F −1 ⋅ e )

1

n

and eqV = (B −1 ⋅ d )

1

n

(VI.4)

The factors eqS and eqV are then used to adjust the equilibrium area and volume.

III.2

Tidal Pumping

For large macro-tidal estuaries the equilibrium state can have a variable along-estuary concentration,
from a relatively low value at the mouth to a maximum some distance into the estuary. This reflects
flood dominance due to internally generated asymmetry in the tidal flow transporting sediment
landward and ebb dominance due to the river flow moving sediment downstream. The convergence
of the two gives rise to a turbidity maximum at some point in the estuary depending on the relative
strength of the two influences. The landward mechanism has been characterised as tidal pumping
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(Scully & Friedrichs, 2007; Friedrichs et al. 1998) and can be thought of as an upstream directed
discharge and associated sediment flux. For a convergent channel, the equations of mass continuity,
momentum and the advection-dispersion are solved to obtain the net sediment flux, which can be
expressed as (Friedrichs et al. 1998 eqn (18)):

aeff
⎧ u
a
3
1TU⎫
J = U ⋅ c m ⋅ α ' ⎨− river +
kx − 2 sin θ 2 + c ⎬
2
h
a
4 Lw ⎭
⎩ U

(V1.1)

where
J = net sediment flux over a tidal cycle,
a = amplitude of the dominant tidal frequency (usually M2 at mouth),
U = amplitude of the tidal velocity,
cm = concentration scale,
α’ = coefficient for sediment mobilisation
a2 = amplitude of the overtide and θ2 = phase of the overtide,
uriver = river flow velocity,
h = average depth of estuary,
x = distance from mouth of estuary,
Lw = e-folding length of width convergence,
aeff = (Hhw-Hlw)/2
Tc = adjustment time scale for the concentration field
k = tidal wave number = 2π/λ, σ = 2π/Tp; c = √(gh) and λ = cTp.
For use in ASMITA we note that the river discharge is already handled and that concentration is
defined locally for each element. We can therefore re-write (V1.1) as a discharge where in addition
we will need to specify the following parameters:
aM4 = a2 , phM4 = θ2, and eLw = Lw
And calculate the following from parameters already defined:
hhw = Vhw/Shw; hlw = Vlw/Slw; aeff = (hhw-hlw)
h = (hhw+hlw)/2;

U = σ.a.Lw /h; xi = ΣeLe(downstream)+eLei

Tc ~ h/ws where ws is the settling velocity (p321 of paper)
Ai = (Vp/2+Vc)/Lc is the average cross-sectional area of the channel element. A=(Ai+Aj)/2 where i and
j relate to the element that the flow is going from and to.

qtp =

3 σ ⋅ a ⋅ Lw ⎧ aeff
1 σ ⋅a⎫
a
A⎨
kx − 2 sin θ 2 +
⎬
2
h
a
4 ws ⎭
⎩ h

(V1.2)

The matrix for qtp has the same form as that for advective flow, q. There is an additional term to be
included in F, ee, B and dd when calculating eqV and eqS and in the main time loop.
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Appendix IV

Definition of Equilibrium

ASMITA works by relating volumes (and areas) to some equilibrium value that, if equal, would result
in uniform concentration throughout the system. The most common way of doing this is to define a
relationship with the tidal prism for each type of element (or for each individual element). This
section explores the basis of an equilibrium based on the tidal prism in a UK context and an
alternative approach based on an Equilibrium profile

IV.1

Tidal Prism Equilibrium Relationships

Equation I.1 postulates a link between the equilibrium volume and the tidal prism. Similarly the value
of the equilibrium surface area Se in Equation III.6 can be assumed to vary with the tidal prism.
Townend (2005) showed that the tidal prism exhibits a strong correlation with the plan area and
volume of the estuary. From a sample of 66 UK estuaries he found that the total surface area, total
volume and tidal prism exhibited the following relationships:
Smtl = 0.42P0.96,

R2 = 0.92;

Vmtl = 0.073P1.13,

R2 = 0.92.

(IV.1)

The elements used within ASMITA comprise deltas, channels and tidal flats. The UK estuaries
database suggests that the channels and flats (when represented as a single element) can be adequately
represented by simple linear relationships with exponents of one:
Table IV.1 Linear form-prism ratios
Volume
Channel
Vc = 0.418P
Tidal flats
Vf = 0.163P

R2
0.93
0.74

Surface Area
Sc = 0.076P
Sf = 0.077P
Sf = 28.9P0.75

R2
0.95
0.47
0.82

However, individual estuaries can have values significantly different from the above. The following
are the average values for the Humber over the period 1851-2000 (based on 22 bathymetric data sets)
with standard deviations indicating a small variation over time:
Table IV.2 – Linear form-prism ratios for the Humber Estuary
Volume
St.dev Surface Area
St.dev
Channel
Vc = 0.738P
0.021 Sc = 0.130P
0.003
Tidal flats
Vf = 0.249P
0.011 Sf = 0.067P
0.003
One of the strongest correlations revealed by the UK data is between the surface area at mean tide
level, prism and tidal range, which takes the form:

S mtl = 1.07

P
tr

(R2 = 0.996)

(IV.2)

This implies that the tidal prism is essentially the plan area at mean tide multiplied by the tidal range
(particularly for the larger estuaries with P>107m3) and that the cross-shore shape of the intertidal is of
secondary importance. Although the regression is strong it must be recognised that the error in
predicting the plan area of an individual estuary can still be ±30% based on this data set, with most of
the data points falling below this forced regression line (ie exponent=1 and intercept=0). The surface
area at low water is also reasonably well represented by this form of relationship but the area of the
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tidal flats shows a poorer correlation, Table IV.3. The coefficients specific to the Humber are similar
for the mean tide and channel (mlw) relationships but differ significantly for the tidal flats.
Table IV.3 Linear form-prism ratios for surface area as a function of P/tr
UK estuaries
R2
Humber estuary
Channel
Sc = 0.775P/tr
0.97 Sc = 0.733P/tr
Tidal flats
Sf = 0.945P/tr
0.77 Sf = 0.386P/tr
Mean tide level
Smtl= 1.07P/tr
0.99 Smtl = 0.96P/tr
A more detailed exploration of the inter-estuary, along-estuary and temporal variation of selected
gross properties with tidal prism is provided in Appendix IV(a).

IV.2

Equilibrium Profile

An alternative approach is to use the equilibrium hypsometry relationships for channels (Cao &
Knight, 1997) and tidal flats (Friedrichs & Aubrey, 1996) to define the form of the estuary crosssection, Figure 1. The resulting relationships can then be written in terms of volume and surface area
by considering a representative length. Some trials for a number of estuaries suggest that this form
description provides a reasonable characterisation of estuary cross-sections.
Figure IV.1 – Definition sketch for equilibrium form of channel and intertidal

From Friedrichs and Aubrey (1996, p414, eq(15)) we have the intertidal described by:

⎛ y'
⎞
− 1⎟
z = a ⋅ sin ⎜
⎝ L* ⎠

(IV.3)

where y’ = y - Lc. If we assume a symmetric channel it follows that:
W’ = W – Wlw and L* = (Wo – Wlw)/2 , or more generally L* = (Wo – Wlw)/nbk
where nbk is the number of banks.
Whence

and

⎛ n y − Wlw ⎞
z = a ⋅ sin⎜⎜ bk
− 1⎟⎟ for
⎝ Wo − Wlw
⎠

y≥

Wo
nbk

⎛ n y − Wlw ⎞
Wlw
W
z = a ⋅ ⎜⎜ bk
− 1⎟⎟ for
> y< o
nbk
nbk
⎝ Wo − Wlw
⎠

(IV.4)

(IV.5)

Using entropy concepts Cao & Knight (1997) derive a parabolic equation for channel form:
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μWlw ⎡

⎛n y⎞ ⎤
⎢1 − ⎜⎜ bk ⎟⎟ ⎥
d ( y) =
(IV.6)
2nbk ⎢ ⎝ Wlw ⎠ ⎥
⎣
⎦
Where d is the depth at a distance y from the centreline, μ is the submerged static friction factor taken
to be equal to tanφ, where φ is the angle of repose of the sediment. The value of m largely determines
2

the aspect ratio. More generally, one might consider the exponent of 2 to be a variable, n. This
determines the shape of the channel, the larger the value the closer the form is to a rectangular
channel.
Consequently the cross-section of the estuary can be prescribed over three intervals:

⎛ n y − Wlw ⎞
z = a ⋅ sin⎜⎜ bk
− 1⎟⎟
⎝ Wo − Wlw
⎠
⎛ n y − Wlw ⎞
z = a ⋅ ⎜⎜ bk
− 1⎟⎟
⎝ Wo − Wlw
⎠
z = −a −

μWlw ⎡
2nbk

⎛n y⎞
⎢1 − ⎜⎜ bk ⎟⎟
⎢⎣ ⎝ Wlw ⎠

for a > z > 0
for 0 > z > − a
n

(IV.7)

⎤
⎥ for z < − a
⎥⎦

Friedrichs and Aubrey (1996) show that the lower intertidal width is a function of the equilibrium
flow velocity and the angular tidal frequency: (wo-wlw) = ueq/ω. This implies that the lower intertidal
width reflects flow field, the erodibility of the sediments and the rate of convergence of the estuary.
We therefore assume that the slope of the lower intertidal is a characteristic value, which in terms of
surface area is given by:

meq =

Wo − Wlw
nbk a

(IV.8)

Now by assuming representative reaches the widths can be treated as surface areas. Furthermore
integrating equations (IV.7) over the respective intervals provides cross-sectional areas of the upper
and lower intertidal and channel, respectively. Again taking representative reaches allows these to be
treated as volumes.
Using the initial estuary surface areas at mtl and lw, with the tidal range, the equilibrium slope can be
calculated using equation (IV.8). Taking n=2, the value of μ can be obtained as the ratio of the
volume and area at low water, with the introduction of the element length, Le. If the slope, meq and
coefficient μ are treated as being constant, equations (IV.9) can be used to derive updated equilibrium
volumes and areas for the channels and flats given a new value of the tidal prism.

S lw =

P
− nbk ⋅ a ⋅ meq
2a

⎛ π⎞
S fl = ⎜1 + ⎟ ⋅ nbk ⋅ a ⋅ meq
⎝ 2⎠

Vlw =

μ

S lw
nbk (n + 1) Le

2

⋅

1+ π
V fl =
nbk ⋅ a 2 ⋅ meq
2

(IV.9)

Based on the data from 66 UK estuaries these relationships are found to give reasonable
representations, Figure IV.2.

ASMITA_lite manual v1.0.doc

52

Feb 2010

ASMITA_lite MANUAL

Figure IV.2

Comparison of Equilibrium Profile estimates against observed values
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Source file: Eq Hyps fits to JCR data.xls
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Appendix V

ASMITA_lite model sub-routine structure

The file ‘ASMITA_lite Program Structure.xls’ list the subroutines used in the program.
Description
Initiate user interface for asmita
Define global variables
Initialise variables and set default values

Routine name & level
1
2
3
asmui
defglob
vardef

Define figure for main user interface

4

5

new_project
cb_fil1
cb_fil2
cb_fil3
exit_fig

Load a background map or image
Save an image of the model window to a jpg file
Redraw map and elements

cb_fil4
cb_fil5
drawmap

Clear the model from memory
Clear all open output plots

clear_model
clear_figs

Load existing/default system property values, call input form
Input system properties
Load new values into global variables
Load existing/default water level values, call input form
Input system properties
Load new values into water level variables

gb_elm2

Create new change .xls file based on model as defined
Edit existing change .xls file
Load selected change file into global variables
Prompts user for excel file name
Reads selected file into the change variable

Systemchange(0)
Systemchange(1)
Systemchange(2)
GetExcel
CheckExcel

Define new element (draw defining box in window)

cb_elm1(0)

Right mouse click on element to select Properties
Load existing/default element property values, call input form
Input individual element properties
Load new values into global variables

rm_elm2
cb_elm2

Right mouse click on element to select Flow
Load existing flow values, call input form
Get index of element clicked on by user
Select elements and define flow
Load new values into global variables
Right mouse click on element to select Diffusion
Load existing horizontal exchange values, call input form
Select elements and define exchange
Load new values into global variables
Right mouse click on element to select Resize
Right mouse click on element to select Delete
Delete an element

rm_excq
cb_excq

Load existing/default run time values, call input form
Input individual run time settings
Load new values into global variables

cb_run1

gbspec_fig
gb_spec
wl-elm
wlspec_fig
wl_spec

elspec_fig
cb_spec
getindex

getelem
exchq_fig
q_ready
rm_excd
cb_excd
exchd_fig
d_ready
cb_elm1(1)
rm_elm3
cb_elm3
timest_fig
cb_run1a

Carry out some diagnostics to check model is correctly specified
cb_run4
Run model
cb_run2
Main computational routine that unloads variables from
global defintions, initialises all variables required in
calculation and runs the time step loop
Subroutine to set up matrices defining element linkages
Subroutine to define equilibrium coefficients for mu, meq
Subroutine to calculate high water volume
Subroutine to subtract volume of expanding element from contracting element
Subroutine to calculate equilibrium S and V
Subroutine to calculate tidal prism
Subroutine to set equilibirum coefficients based on initial definition of elements
Write output to excel file
Print all input parameters to text and xls files
Routine to handle writing to Excel spreadsheets
Utlity to plot results
Add to current plot
Create a new plot
Delete line

Defines the calls for drop down menus
File
File/New
File/Open
File/Save
File/Save As
File/Exit
Tools
Tools/Load Image
Tools/Model Image
Tools/Refresh
Tools/Clear
Tools/Clear/Model
Tools/Clear/Figures
Setup
Setup/System
Setup/System/Properties
Form
Called by Ready button on form
Setup/System/Water levels
Form
Called by Ready button on form
Setup/System/Change
Setup/System/Change/New
Setup/System/Change/Edit
Setup/System/Change/Load

Setup/Element
Setup/Element/Define
Setup/Element/Specify
Properties
fig menu in drawmap
Setup/Element/Specify/Properties
Form
Called by Ready button on form
aslo called in tf_spec, q_ready and d_ready
Flow
fig menu in drawmap
Setup/Element/Specify/Flow
also called in cb_excd
Form
Called by Ready button on form
Diffusion
fig menu in drawmap
Setup/Element/Specify/Diffusion
Form
Called by Ready button on form
Resize
fig menu in drawmap
Delete
fig menu in drawmap
Setup/Element/Delete
Setup/Time Step
Form
Called by Ready button on form
Run
Run/Check Input
NB this incomplete
Run/Run Model
Also includes checks

asmita
ele_link
mu_meq
hw_vol
ele_Vcorr
eq_vands
prism
eq_coefs
writedata
cb_print
xlswrite1

plot_fig
add_grp
new_grp
del_grp
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Notes

Header includes definitions of all global variables

moddef_fig

Create a new model
Open an existing model
Save the model to existing file
Save the model to a new file
Exit the program

ASMITA_lite manual v1.0.doc

6

Plot
Plot Results
Add button
New button
Delete button
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